


BSBITU302

Create electronic
presentations

Release 1

Learner guide

Aspire Version 1.1

4dspire

" learning resources



Copyright Warning

This product is copyrighted to Aspire Training & Consulting
(ABN 51 054 306 428).
Aspire Training & Consulting owns all copyright to its products. Except as permitted

by the Copyright Act 1968 (Cth) or unless you have obtained the specific written
permission of Aspire Training & Consulting, you must not:

reproduce or photocopy this product in whole or in part
publish this product in whole or in part
cause this product in whole or in part to be transmitted
store this product in whole or in part in a retrieval system including a computer
record this product in whole or in part either electronically or mechanically
resell this product in whole or in part.
Aspire Training & Consulting:
+ invests significant time and resources in creating its original products
protects its copyright material
will enforce its rights in copyright material

reserves its legal rights to claim its loss and damage or an account of profits made
resulting from infringements of its copyright.

Aspire is committed to developing quality resources that meet the needs of our customers. However,
occasionally Aspire finds, or is notified of, errors. Please refer to our website at www.aspirelr.com.au to see if
there are any updates that may be relevant to you.

Every effort has been made to ensure the information in this book is accurate; however, the author and
publisher accept no responsibility for any loss, damage or injury arising from such information.

Except where an information source is acknowledged, the names and details of individuals and organisations
used in examples are fictitious and have been devised for learning purposes only. Any similarity to actual
people or organisations is unintentional.

All websites referred to in this unit were accessed and deemed appropriate at time of publication.
Aspire Training & Consulting apologises unreservedly for any copyright infringement that may have occurred
and invites copyright owners to contact Aspire so any violation may be rectified.

BSBITU302 Create electronic presentations Release 1

© 2017 Aspire Training & Consulting
Level 1, 464 St Kilda Road
MELBOURNE VIC 3004 AUSTRALIA
Phone: (03) 9820 1300

First published April 2017

Cover design: Rewind Creative
Printer: Doculink Australia Pty Ltd, 1d/28 Rogers Street, Port Melbourne VIC 3207

e-ISBN 978-1-76059-438-1 (PDF version)
ISBN 978-1-76059-437-4



Contact details

Participant

Name:

Start date:

Phone number:

Email:

Work location

Name:

Address:

Postal address:

Workplace supervisor name:

Phone number:

Fax:

Email:

Registered Training Organisation (RTO)

Name:

Address:

Postal address (if different):

Phone number:

Fax:

RTO contact name:

Mobile:

Email:







Contents

Before you begin

Topic 1: Prepare to create a presentation

1A
1B
1C
1D

Use safe work practices
Determine the purpose, audience and method of presentation
Identify the presentation requirements

Use conservation techniques

Summary

Learning checkpoint 1: Prepare to create a presentation

Topic 2 : Create presentations

2A
2B
2C
2D
2E

Understand organisational style requirements
Use software functions

Balance presentation features

Use advanced software features

Work to a time line

Summary

Learning checkpoint 2: Create presentations

Topic 3: Finalise presentations

3A
3B
3C
3D

Overcome problems
Proofread your presentation
Print presentation materials

Store your presentation

Summary

Learning checkpoint 3: Finalise presentations

Vii

12
16
20
25
26

33

34
37
49
57
61
63
64

71

72
75
79
83
88
89

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting






Before you begin

This learner guide is based on the unit of competency BSBITU302 Create electronic
presentations, Release 1. Your trainer or training organisation must give you
information about this unit of competency as part of your training program. You
can access the unit of competency and assessment requirements at:
www.training.gov.au.

How to work through this learner guide

This learner guide contains a number of features that will assist you in your
learning. Your trainer will advise which parts of the learner guide you need to
read, and which practice tasks and learning checkpoints you need to complete. The
features of this learner guide are detailed in the following table.

Feature of the How you can use each feature
learner guide

Learning content  Read each topic in this learner guide. If you come across content that
is confusing, make a note and discuss it with your trainer. Your trainer
is in the best position to offer assistance. It is very important that you
take on some of the responsibility for the learning you will undertake.

Examples and Examples of completed documents that may be used in a workplace
case studies are included in this learner guide. You can use these examples as
models to help you complete practice tasks and learning checkpoints.

Case studies highlight learning points and provide realistic examples of
workplace situations.

Practice tasks Practice tasks give you the opportunity to put your skills and knowledge
into action. Your trainer will tell you which practice tasks to complete.

Video clips Where QR codes appear, learners can use smartphones =% 5]
and other devices to access video clips relating to the r_';;‘: i
content. For information about how to download a QR EIEL »
reader app or accessing video on your device, please visit "R
our website: www.aspirelr.com.au/help 0

Summary Key learning points are provided at the end of each topic.

Learning There is a learning checkpoint at the end of each topic. Your trainer will

checkpoints tell you which learning checkpoints to complete. These checkpoints

give you an opportunity to check your progress and apply the skills and
knowledge you have learnt.
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Foundation skills

As you complete learning using this guide, you will be developing the foundation
skills relevant for this unit. Foundation skills are the language, literacy and
numeracy (LLN) skills and the employability skills required for participation in
modern workplaces and contemporary life.

The following table outlines specific foundation skills noted for your learning in

this learner guide.

Foundation skill area

Reading

Writing

Oral Communication

Navigate the world of work

Interact with others

Get the work done

Foundation skill description

Evaluates and integrates information and ideas to
construct meaning in an effort to design and create a
presentation

Communicates relationships between ideas and
information in a style appropriate to audience and
purpose in accordance with organisational and task
requirements

Listens to discussions and participates in exchange
of information to choose appropriate actions to create
presentation

Recognises and follows explicit and implicit protocols
and meets expectations associated with own role

Collaborates with others to achieve joint outcomes

Uses advanced features within applications to address
routine and complex work tasks

Plans and implements routine tasks and workload
making limited decisions on sequencing and timing

viii
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Before you begin

What do you already know?

Use the following table to identify what you may already know. This may assist you

to work out what to focus on in your learning.

Topic

Topic 1 Prepare to
create a presentation

Topic 2 Create
presentations

1A

1B

1C

1D

2A

2B

2C

2D

2E

Key outcome

Use safe work practices

Determine the purpose,
audience and method of
presentation

Identify the presentation

requirements

Use conservation techniques

Understand organisational style

requirements

Use software functions

Balance presentation features

Use advanced software features

Work to a time line

Rate your confidence
in each section
U Confident

(] Basic understanding
L Not confident

U Confident
U Basic understanding
U Not confident

1 confident
(] Basic understanding
L Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
L Not confident

U Confident
U Basic understanding
L Not confident

U Confident
U Basic understanding
U Not confident

U Confident
[ Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

continued ...

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



BSBITU302
Create electronic presentations

... continued

Topic 3 Finalise 3A Overcome problems

presentations

3B Proofread your presentation

3C Print presentation materials

3D Store your presentation

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
U Not confident

U Confident
U Basic understanding
L Not confident
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Topic 1
Prepare to create a presentation

Most organisations need people with skills in designing and producing electronic
presentations. This function may be part of an administrative role. To work
effectively in this area, you need to prepare your workspace by understanding
safe work practices and by knowing how to identify hazards or risks to reduce
workplace injury. While a lot of the responsibility for workplace safety lies with
the employer, employees must also make an active contribution to ensure their
workplace is safe.

When creating presentations in an office environment, you may need to use a
range of business equipment and technology including a computer, photocopier,
printer, fax machine, shredder and audio-visual equipment such as a projector,
DVD and/or television. You must know how to use this equipment and technology
safely and effectively.

To prepare a quality presentation, you must also be well informed. You need
to take the time to understand the purpose of the presentation, which includes
knowing who it is for (the audience), how it should be presented and in what
format. Being well informed helps you to create a relevant and professional
presentation.

You should also consider resource conservation and the implementation of
organisational strategies to prevent waste when preparing a presentation.

In this topic you will learn how to:

1A Use safe work practices
1B Determine the purpose, audience and method of presentation
1C Identity the presentation requirements

1D Use conservation techniques
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1 A Use safe work practices

Workplace safety is everyone’s responsibility. Employers and employees must make
an active contribution to ensuring their workplace is safe. Hazards need to be
identified and risks assessed to reduce injury in
the workplace. If you are working at a computer
for an extended period each day, your
workstation must be comfortable and designed
for you to carry out your tasks efficiently. You
will need to organise your work so that you are
not doing a repetitive task for a long time. You
should also take time to stand up and stretch.

Workplace safety legislative requirements

All work health and safety (WHS) legislation requires employers to provide

a safe workplace and adequate training and supervision, while controlling
workplace hazards and risks. You must work in line with legislative requirements,
regulations, Australian and industry standards, and the relevant codes of practice.

WHS legislation describes the legal requirements for ensuring workplaces are safe
and healthy, such as:

managing risks to health and safety
« promoting and maintaining the health, safety and welfare of people at work
 protecting people at work from injury and illness, including
psychological injury
o protecting the health and safety of the public in workplaces
» consulting workers and encouraging participation in maintaining WHS

« providing rehabilitation and maximum recovery for injured workers.

WHS policy

All workplaces in Australia are required to have a WHS policy that describes the
organisation’s responsibility for the health and safety of its employees. The policy
should include the organisation’s goals and objectives regarding WHS and a
general set of guidelines related to health and safety in the workplace.

The WHS policy will help you fulfil your duty of care as a worker for the
organisation.
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WHS procedures

WHS procedures are instructions developed to ensure all employees work safely
and effectively. In the context of working in an office and using a computer
workstation, the following information should be contained in an organisation’s
WHS procedures.

Information contained in WHS procedures includes:

« workstation ergonomics

 standard safety precautions and housekeeping

 safe handling of hazardous substances (e.g. cleaning products)

« emergency and fire drills

« hazard identification and risk control

« manual handling

« emergency contact numbers, including local doctors and hospitals

 location of first-aid equipment and first-aid officers.

Standard precautions

Your workplace may need you to use standard
precautions, particularly work practices related to
the prevention of repetitive strain injuries (RSIs).
These include ergonomic practices, workstation
design, enforced breaks and exercise routines.

Workers in an office environment follow standard
precautions when using a computer workstation.
However, research on sitting has demonstrated
that other precautions also need to be considered,
such as the use of standing workstations, to
ensure that injuries are prevented. It is important
that you carefully follow any standard precautions
that are prescribed for your workplace.

Equipment and systems safety checks

An important part of your daily work routine is to check the various systems and
equipment you will use during the day to make sure they are in correct working
order. Your workplace policies and procedures should include the steps to follow.
You may need to perform this procedure at the start of your working day or at
specified intervals during the day.

Workstation safety procedure/checklist:

 Seat is positioned in front of your computer and you can reach your keyboard
comfortably.

Unit release 1 (Aspire Version 1.1)
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« Computer monitor is positioned out of direct sunlight and at the correct
height.

« Environment is dust-free as dust can affect the monitor or central processing
unit of a computer.

« Cables are secured so no-one trips over them.

« Blinds and window coverings are used to reduce glare and heat at your
workstation.

o Temperatures don’t exceed 26°C and humidity is between 40 and 60 per cent.

Use ergonomic practices in the workplace

The aim of ergonomics is to reduce the risk of
accidents, injury and ill health by applying safe work
practices. Ergonomics is about creating comfortable
working conditions by adapting workstations, tools
and equipment to an individual worker’s needs. It
also improves performance and productivity in the
workplace. Ergonomics covers all aspects of working,
from physical stresses such as sitting at a workstation
all day to environmental factors such as noise, air-
conditioning and lighting.

Set up your workstation

A workstation includes a computer, screen, keyboard, mouse, desk and chair. How
your workstation is designed can affect your health and wellbeing. Several physical
problems can result from poor workstation design; for example, lower back strain
may result from sitting in a chair that does not support your back. Below are some
guidelines for setting up your workstation to be ergonomically efficient.

Chair \

Adjust your chair height so that your feet are flat on the floor, your
thighs are horizontal and your lower legs are vertical to the floor.

Adjust the backrest by raising it to the maximum height and

then lower it until it fits the curve of your lower back. If this is not
comfortable, lower it another couple of centimetres. Continue this
until a comfortable position is found. The backrest should support
your lower back.

The backrest may also be adjusted backwards and forwards.
When seated in your usual working position, move the backrest
until it exerts a gentle pressure on your lower back. Make sure
there is at least two centimetres of space between the front of the
seat and the back of your knees. Armrests should be positioned so
that they do not interfere with carrying out your tasks.

\_ /
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Desk \

When you sit at your desk, the surface should be just below your
elbow height. If your desk is not height-adjustable, try to raise your
chair so you are sitting at the correct height, and use a footrest to
make up the difference. If your desk is too low, you may be able to
extend the legs. You should have plenty of leg space underneath
your desk. Don’t clutter the space with bags and bins, as your
legs may become cramped and your posture twisted. Position any
equipment or materials you use so that you can reach them easily
without twisting. For example, stationery items you frequently use
should go in the top desk drawer, and your keyboard and screen
should sit directly in front of you to avoid having to angle or twist
your body.

\_ /

Keyboard N\

The angle of your keyboard can be adjusted to suit your comfort
level by moving the supports underneath it. Place the keyboard as
close as possible to the front of your desk. Don’t place documents
between yourself and the keyboard, as stretching will eventually
cause muscle strain in your arms, shoulders and neck. While
typing it is best not to rest your wrists, as they should not be bent
up, down, or to the side. The knuckle, wrist and top of the forearm
should form a straight line. Wrist supports or rests give you a place
to rest your hands only when pausing from typing, not while you
are typing. Do not pound the keys; use a light touch. Leave enough
room on your desk to put the keyboard out of the way when you
are not using it.

\_ /

Mouse \

Place the mouse and mouse mat directly beside your keyboard on
the side you prefer. If you use the mouse frequently, you could try
to alternate sides. You will be surprised at how easy this becomes
with practice. Your wrist should be straight, and the desk should
support the weight of your wrist, not your arm. Try to keep your
wrist flat and rest your fingers on the mouse between clicks. Hold
the mouse lightly. Don’t hold onto the mouse when you are not
using it.

Unit release 1 (Aspire Version 1.1)
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Screen \

Once you have adjusted your chair and desk, you can position
your screen. Adjust it so that the top of the screen is level with or
slightly lower than your eyes. If you can’t adjust the screen to the
correct height, place the screen on a platform.

The screen should be at least 50 centimetres or an arm’s
length away from your seated position to minimise radiation
exposure; however, you should always adjust the position of the
screen to suit you. It is best to position the screen so that you
can clearly read the text without leaning forward, twisting your
neck, or looking too far upwards. Also take surrounding factors
into consideration, such as reflection, glare and shadow, when
positioning your screen.

\_ /

Workstation features

The features of an ergonomic workstation are highlighted in the diagram below.
Some features of the workstation may vary depending on the type of computer
work being performed. Graphic work may require the use of a pen tool, and
multiple monitors are commonly used for a variety of digital work.

Top of screen The screen angle should be adjustable between 85 and 125
degrees to the horizontal.

Centre of screen Minimise screen reflection and glare by using an anti-glare filter.

Bottom of screen Place a document holder beneath or beside the screen at the
same viewing distance as the screen.

Top line of sight The viewing distance should be between 400 mm and 700 mm.

Bottom line of sight A relaxed viewing angle is approximately 35 degrees.

continued ...
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... continued
Head
Shoulder
Elbow

Above knee

Below knee

Footrest

Back of chair

Under chair

Chair legs

Keep your head erect.
Have your upper arms hanging freely.
Have your forearms approximately horizontal.

Ensure there is clearance between the lower edge of the desk and
your legs.

Ensure there is clearance between the front edge of the seat and
the lower leg.

Use a footrest if needed.

The back support should be adjusted to support the small of your
back.

Adjust the seat height to suit your furniture and equipment.

Use a chair with a five castor base.

Desktop layout

A\ I ‘ N

\ P
F

Items on your desk, including equipment and resources, should be arranged

within easy reach.

Your desk area can be divided into three zones:

 the optimum reach zone - the area closest to you, where your hands operate

most of the time

« the maximum reach zone - further away, but still close enough to reach

comfortably

o the outer reach zone — where you may have to bend forward or stand to

reach items.

Make sure your desk is organised so that frequently used objects, such as your
keyboard, are close to you. Intermittently used objects, such as your phone, should
be out of the way but still within easy reach. Other resources used less frequently,
such as in- and out-trays, should be in the outer reach zone.

Unit release 1 (Aspire Version 1.1)
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Adjust your equipment and posture

When your posture is poor, you may suffer from aches and pains. Spending a long
time in the same position can put stress on your body and this can be made worse
if you are in an uncomfortable or poorly supported position. These symptoms may
start out very slight, but if you continue to use poor posture they may get worse
and become intolerable. They may result in cumulative stress given the constant
stress on your muscles, nerves or tendons. When setting up your workstation,

you need to make sure your posture will not cause you pain or discomfort. The
equipment you use needs to be adjusted to suit your body shape and size, and the
tasks you are doing.

You have already looked at adjusting your screen and chair. There are other office

tools that can help your posture. These include the following items.

Document holders

Document holders are designed to
hold papers and reference material in
a convenient position for viewing. Place
your document holder in the correct
position. If it is below the screen or too
far off to the side, each time your eyes
look from one source to the other, your
pupils have to adjust. Doing this for long
periods of time can cause headaches
and eyestrain. Place the document
holder at a similar level, angle and
distance as the screen to avoid having
to shift eye focus.

Footrests

A footrest may be necessary if you can’t
place your feet comfortably on the floor.
Footrests allow your feet to rest at the
correct height and on a tilting angle,
which prevents strain on the lower
back.

Angle boards

Angle boards allow the user to maintain
correct posture when reading, by
reducing the angle between the work
surface and the vertical posture.
Adjustable to a suitable height

and angle, these supports enable
comfortable reading with the neck
correctly positioned. Try to keep your
neck as straight as possible when you
are reading.

Headsets

If you use a telephone for long periods
of time, itis a good idea to use a
headset. A headset will keep your neck
straight and your arms free. Headsets
prevent you from bending your neck to
support the telephone handpiece.

Monitor environmental factors

Environmental issues in the workplace include lighting, noise control and air
quality. If the environment of your workplace is not monitored and controlled, you
may suffer from headaches, fatigue, hearing loss or eyestrain.

Unit release 1 (Aspire Version 1.1)
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Light

Good lighting is essential for a safe and hazard-free workplace. You need to see
things clearly to work effectively. Simply shifting the screen slightly, adjusting
blinds, altering the brightness settings on the screen and using desk lamps can
avoid many light hazards. Try to use natural sunlight if the office layout can
accommodate this. If not, keep bulbs and fixtures clean, focus light on your task
and use fluorescent lights if possible.

Improper lighting can cause eyestrain and headaches.

Hazards associated with lighting include:

» glare - a computer screen positioned in front of a bright window can be
difficult to see

o flickering lights — a fluorescent light may malfunction, causing annoyance,
irritation and nausea

« inadequate or dim light - reading in dim light causes eyestrain
« reflections - sunlight reflecting on a screen can make it difficult to read

« shadows - shadows shifting across your work area can cause you to sit with
bad posture in order to read your work.

Noise

Noise can include any annoying or disturbing sound. Excessive noise around
heavy machinery or equipment can cause permanent hearing loss. Noise is a
problem if it disturbs people, distracts them, interferes with communication,
causes people stress or generally interferes with their work.

Many offices are open-plan in design, often with employees seated close to each
other and divided by partitions at chest or head height. Think about noise levels
when you set up your workstation. It should be possible for people in open-plan
offices to have some privacy when they are on the telephone and carrying out their
day-to-day activities.

Noise in the office can come from:

« machines (photocopiers, fax machines, printers)

« other equipment (telephones, paging systems, music)

« background noise (lifts, air-conditioning, traffic)

» people talking.

Noise management

Noise can also be a problem outside office environments,
such as on factory floors, at construction sites or near
airports. You may have to wear ear protection if you are
required to work in excessively noisy areas.

Unit release 1 (Aspire Version 1.1)
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There are many ways that problem noise can be controlled in the workplace. Noisy
machines can be put in a separate room or area. Sound-absorbent materials such
as carpet and partitions can be installed or arranged to deflect and absorb noise.
The volume level on your telephone’s speaker can be adjusted.

Remember that noise is only a hazard when it is stopping you from working
productively, comfortably and safely. Many people prefer to work with low levels of
noise rather than complete silence.

Air

Air-conditioned offices do not have fresh air from open windows. This can cause
problems for some people.

Office workers frequently complain of being too hot or too cold. If a person’s desk
is near an air-conditioning outlet, the area around their desk can be much colder
than elsewhere in the office. They can also suffer from dry and itchy eyes. Report
such hazards to the relevant person. This situation can usually be corrected by
adjusting air-conditioning flow.
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Practice task 1

Here is a checklist to follow when setting up your workstation. Go through the points that
are relevant to you and make any necessary adjustments to your work or study space.
You may need another person to help you and check your posture. If you are not able to
tick some of the checkpoints, change your study space or discuss making alterations to
your workstation with your manager.

Chair

Is the seat height-adjustable?

Is it high enough to allow you to sit comfortably over the keyboard?

Is it stable?

Does it swivel?

Is the height of the backrest adjustable and does it tilt backwards and forwards?
If it has arms, can you still get close enough to the desk and swivel the chair?
Are your feet flat on the floor, or are you using a footrest?

[y Ry Ay Sy Ny W

Are you sitting up straight with the backrest firm against your back?

Desk

U Is it large enough to allow the screen and keyboard to be correctly positioned?
O Is it low enough to allow you to keep your forearms horizontal or sloping downwards?
O Is it high enough to allow your thighs to fit underneath it?

Keyboard

0 Can it be tilted to allow you to adjust it?

U Are the symbols on the keys clear and easy to see?

QO Is there sufficient space in front of it to allow you to correctly position your arms?
Screen

O Does the screen have easily adjustable brightness and contrast controls?

U Is the image on the screen stable and flicker-free?

U Are there adjustment mechanisms to allow the screen to be tilted, swivelled or raised
to avoid glare and reflections and help you keep a natural and relaxed posture?

U Are you sitting far away enough from it for comfort?
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Determine the purpose, audience

and method of presentation

Sharing information is a necessary activity in every workplace. You may have to
take part in a staff meeting or read a newsletter, and you will probably present
information at some time in your career. Information can be presented in written,
graphic or verbal form. You need to be able to communicate in all of these ways.

During this topic you are going to learn how to prepare and produce an electronic
presentation.

Before you start you need to determine:

 the purpose of your presentation

» who your audience is

o how you will present the material.

Presentation planning

Content
Organisational

Purpose
Audience

requirements
Method

Style and layout

The purpose, audience and method of your presentation will influence its content,
organisational requirements, style and layout.

Many presentations are made with the input of another person, or created by a
team. Sometimes people in the team have specialist abilities and knowledge that
needs to be presented at the right time, in a specific format within a presentation.
All of these factors will affect your ability to communicate with the intended
audience, and the way you choose to present the content.

It’s also important that you are aware of any legislation or codes of practice
that may apply to the information in your presentation. For example, make
sure you comply with privacy laws (using only authorised material) and follow
anti-discrimination and ethical principles to be confident your content does
not contravene these guidelines. In particular, work with your team to ensure
that people with special needs have access to the information. When you are
new to presentations, always have your work checked by your supervisor or an
experienced colleague to make sure you have complied with relevant legislative
requirements.

We will now take a closer look at each one of these factors and how they might
influence the way you plan a presentation.

12
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Purpose

What is your electronic presentation about? You may have been asked to present
information on a specific topic, or you may have decided to present something
that you believe will benefit your colleagues. Whatever your purpose, make sure
you fully understand what your presentation is about.
You should be aware of the intended message; that is,
what you want your audience to know. Your ability to
explain clearly with words, text and graphics determines
how clearly your message comes across. Start by writing
a precise statement of the purpose of your presentation;
for example, ‘T have to explain new health and safety
regulations to my colleagues’.

Storyboards

Conclusions
Topics of Bullet

discussion Bullet
etc.

It is often helpful to create a storyboard to help you understand the purpose of
your presentation. A storyboard is basically an outline of the major points. It
should give a general idea of where text, pictures or charts will go and the order
in which you will talk about them. You can quickly sketch a storyboard by hand
on paper. Identify items that need to be presented earlier or later in the final
presentation. Look for the most logical flow of understanding, or the best impact
on the audience and their retention of the information you are presenting —
rearranging the flow of your work if necessary.

Audience

If you take time to get to know your audience, the electronic presentation you
develop will be more successful. Find out who your audience is. Simple questions
will help; for example:

o Isitan internal or an external client?
o Does the group all come from the same unit/site or do the same job?

o What will they need to do after they have seen the presentation; for example,
will they need to practise a task or skill as part of your planning?

o Are there any people with ability or cultural issues that should be considered
when delivering the message?

o If known, what sort of presentations worked best for the group previously?

Unit release 1 (Aspire Version 1.1)
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It is also important to find out what level of expertise your audience members have
in regard to your subject. If your audience is not knowledgeable about the content
of your presentation, and you include fine details and jargon, people may become
confused and bored. If you are presenting to an external client, ask your manager
for information about them. If you are presenting to an internal client, you could
prepare a questionnaire to find out their level of existing knowledge.

Method of presentation

Whatever presentation method you choose, the way you arrange the information
should depend on the situation. It is important the method suits both the purpose
of your presentation and the audience. It is important to ensure you will hold

the audience’s attention and that your information is easy to absorb. You need to
consider the most useful method for the audience to receive the information and
retain it, rather than assuming it will be enough if they’ve seen it.

Here are several different ways to give a presentation.

Face to face

Presenting face to face with an audience, such as at a seminar or
a staff meeting.

Specialist speaker

Engaging a specialist speaker/demonstrator for certain aspects
of the presentation.

Self-running

Choosing a ‘self-running’ mode, such as a looped video that runs
continuously on a TV monitor at an exhibition stand.

Self-use

Designing a presentation for people to use themselves, such as
at a conference or a training session, with activities to assess
their understanding of the tasks or material.

Online

Setting up the presentation on the internet or the organisation’s
intranet. This enables you to record the identity of the user/
participant and acts as a method of tracking and ensuring
information has been accessed by relevant participants.
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Practice task 2

Read the case study, then answer the questions that follow.

Kate works as an office administrator in a large organisation. Her manager asked her to
prepare an electronic presentation for external clients to explain upcoming projects. The
clients were to view the presentation at a board meeting.

Kate assumed the clients already knew a lot about this topic and focused instead on the
financial details of each project, including forecasted profits. She also used information
that had not been confirmed by management and should not have been included. To
present this information, Kate decided to set up a computer in the boardroom. The
clients were to look at this individually when they had time.

On the day of the board meeting, Kate found out the clients had no prior knowledge of
the future projects and wanted a broad overview. She also discovered that most of the
clients didn’t know how to run the presentation themselves.

1. What should Kate have confirmed before producing the presentation?

2. What are the consequences of Kate’s poor planning?

3. What content would have been more suitable for Kate’s audience?
4. What method of presentation would have been more suitable?

5. Why do you have to understand the purpose, audience and method of presentation before
designing an electronic presentation?
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1 C Identify the presentation requirements

Presentation requirements refer to the many documents and equipment that

may be used to prepare for and deliver an electronic presentation within your
organisation. You will most likely use a computer or laptop, monitor, keyboard and
mouse to deliver an electronic presentation; however, you are also likely to need
other types of business equipment - as outlined below.

Equipment used in presentations

~

1 Data projector or display monitor

A digital projector can be attached to a computer or tablet to project the
computer or tablet display onto a larger screen. A data projector is commonly
used for PowerPoint presentations but it can be used to display almost any
digital multimedia. Many variations on using the data projector concept

are emerging, given it is becoming common to use a large digital television
display monitor instead of a projector. Likewise the connectivity to a projector
or television may not be by direct cabling but may be through a local area
network, Wi-Fi network, internet or other wireless technology such as Apple
TV. The use of this display technology offers many advantages but it always
requires that the equipment is tested before the presentation and that the
presenter is competent in using it.

_/
~

2 Electronic smart boards

Electronic smart boards are an extension to the concept of data projectors
except that they allow the presenter to interact with the display board. For
example, if a computer screen was being displayed onto a smart board, the
presenter could touch the board to operate the computer functions similar
to how they would use a mouse. An extension to this is the use of electronic
pens, which provide the added functionality of using the smart board as a
white board.

Smart boards can also be connected to users in a variety of ways, in
particular the image and actions presented can be shared across a wide area
network with a variety of users.

_/
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~

Digital pointer or annotation pen

When presenting information you might want to draw attention to an
important point within a single screen. A hand-held digital pointer can do this.
You can shine it on the display screen to emphasise a certain area.

PowerPoint and a variety of other computer and tablet applications are now
providing freehand annotation tools that allow the presenter to write on each
presentation slide during the presentation. This can add or draw attention to
existing information. Some tablet based applications can also make provision
for the audience to annotate presentations as a mechanism of audience
engagement.

/
~

Sound equipment and visual monitors

Audio speakers are often required even in smaller rooms, particularly if your
presentation has a video clip or uses sound effects. Sometimes in a large
venue it is necessary to install a background screen or extra screens around
the room so that all participants can see a visual display clearly (without
straining) by looking towards a stage area.

/
N

Network/Internet access

To illustrate certain points you can provide a hyperlink to an interactive
presentation for participants’ use. This may require you to arrange (with your
information technology department) for special access to data and logon
privileges, and to be sure you are not breaching any privacy issues regarding
data that will be displayed.

Further to this, there is a wide variety of presentation technology which
requires either cabled, Wi-Fi or mobile broadband networks to operate. The
use of wireless technology is now common for transmitting all features of
presentations including text, imagery, video and audio components.

\_ /
~

Microphone/lapel microphone

A lapel microphone can be used for the speaker if they are not using a lectern
and standing in one place while they present information. You may also
consider the use of a hand-held microphone to help the audience participate
fully. Assistants can be organised to minimise delays and avoid reducing the
impact of the session.

/
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7 Speaker notes and handouts

Having a hard copy of the presenter’s notes, internet documents or audience
handouts can add value to an electronic presentation.

You may have to write speaker notes or handouts for a presentation that
you are giving. Speaker notes are thumbnail sketches of each slide to be
displayed. They help the presenter remember the important points on each
slide. This helps the verbal presentation run smoothly.

The audience may also require handouts to repeat or add to information
from the presentation. The audience will not remember everything from a
presentation, so handouts are useful, particularly if the presentation is about
something the audience needs to remember. Handouts can be formatted in
a variety of ways and can contain your notes and a space for the audience to
add their own notes. They might include an outline of your presentation, or
information that is useful but not important enough to put on a slide.

Handouts can also be provided in digital format either before or after the
presentation. With the advent of smartphones and tablets, many people
consider an electronic version to be preferable as it reduces paper usage and
is easy to store and access from a mobile device.
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Practice task 3

Decide which of the following statements are true (T) or false (F).
1. Large television displays can be used to project the content of a computer screen.

2. An electronic smart board can allow the presenter to interface with the computer.
3. An electronic smart board cannot be used across a wide area network.

4. A data projector can be attached to a computer wirelessly.

5. Tablets can be used for presentations as effectively as computers.

6. A digital pointer or annotation pen can be used to draw the audience’s attention to main
points.

7. Speaker notes and handouts can only be supplied in print-based format.

8. Presentation equipment is simple to connect to a computer as they all use the same
connection cables.

9. There is no need to test presentation equipment beforehand, as it is all relatively easy to
use.
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Use conservation techniques

The use of resource conservation technique to prevent wastage should be a
consideration in the workplace. Most organisations require staff to follow
resource-saving procedures such as turning off lights in unused rooms and
recycling paper. You need to be aware of any conservation efforts made by your
organisation.

Organise your work

Having a well-planned workstation and comfortable surroundings is pointless if
you don’t organise your work in a way that prevents discomfort or pain. Make sure
you plan your daily tasks so that you aren’t doing repetitive work for long periods
of time. Make sure you take rest breaks and exercise regularly.

Positive work organisation includes:
» amixture of repetitive and other activities
o rest periods

o exercise breaks.

Vary your activities

Your work role may involve several different tasks. Some tasks may be repetitive,
such as typing up reports or entering data. If you are able to vary the tasks you
carry out each day, this will help prevent repetitive actions that cause stress to
your body. For example, if you have to enter a lot of data, break up the repetitive
nature of the task by discussing a project with a fellow worker, collecting some
research from the internet or doing another constructive workplace task you are
responsible for. Workflow should be designed to reduce the repetitive tasks given
to particular people.

Take rest periods

All employers need to provide rest periods for employees. Rest periods include
tea breaks and lunch breaks. During the working day everyone needs to sit down,
breathe easily, relax and take time to think about something other than work.

Have exercise breaks [5]

When working with a computer, you should have short breaks L

at regular intervals to combat stress and prevent pain and @
discomfort. As discussed previously, using computers for too . .
long without breaks has been associated with back and neck :
pain, headaches, migraines and eyestrain. J 9

20
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Try the following exercises several times a day, and encourage others around you
to try them. Make sure you are relaxed and stretch gently, without overstretching.
Stop if you feel any pain or discomfort, and remember to exercise both sides of
your body. Most importantly, breathe deeply and evenly throughout the stretch.

Neck

Shoulders

Wrists, hands and arms

Turn your head gently to look over your right
shoulder. Hold for 10 seconds. Now roll your
head forward to look over your left shoulder
and hold for 10 seconds. Repeat several times.

_

Sitting with a straight back and neck, roll your
shoulders forward, then back. Repeat several
times.

L

Interlacing fingers, turn palms upwards. Now
lift arms over your head and stretch, leaning
gently to the left and then to the right. Repeat
movement several times.

Upper and lower back

\_

In a standing position place hands in the small
of the back. Gently arch back and hold for 10
seconds. Repeat when needed.

Shoulders and arms

Eyes

L

Stretch your arms above your head, cradle
your elbow with your hand and gently pull your
elbow behind your head. Repeat on the other
side, holding the stretch for 10 seconds.

Every 20 minutes, look away from the screen.
Focus on a distant object (more than three
metres away).

N N N N7 N
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Work without stress

Here are some tips for working without stress.

Tips to help minimise stress

e Adjust your chair and desk to suit your body.

¢ Position your screen to suit your posture.

¢ Adjust other equipment for safe and comfortable use.

¢ Reduce excess noise.
e Ensure you have adequate light.

* Arrange your desktop so you can access things easily.

¢ Take regular breaks from your work.
¢ Frequently rest your eyes.

¢ Do stretching exercises.

e Vary your tasks.

Practise conservation techniques

Conserving resources at work benefits not only the
organisation by reducing costs, but also the planet by
reducing greenhouse gases and the amount of waste
sent to landfill. Most organisations have policies and
procedures for conserving resources. You can find out
what these are by reading your workplace manual or
asking your manager or colleagues.

Ways to conserve resources at work include:
e minimising paper wastage

 reducing energy use.

Minimise paper wastage

Wasting paper costs organisations and the planet a great deal. Consequently, many
organisations have developed policies for paper usage. These include:

« using both sides of the paper when photocopying

« recycling non-confidential waste paper in recycling bins

 storing email messages in an electronic folder instead of printing

« reducing the volume of printing where possible

 reusing paper by using blank sides for rough drafts and reusing folders

and files

 using recycled paper or paper from plantation timber for printed documents

« using a recycling service to collect waste paper.

22
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Using the following statistics, consider how many trees are used for office paper.

How many trees are used to produce paper?

The statistics in this example are based on US short
tons (2,000 pounds), not metric tonnes.

Source: www.conservatree.com

One ton of uncoated virgin (non-recycled) printing and office paper uses 24 trees.
One ton of 100 per cent virgin (non-recycled) newsprint uses 12 trees.

One ream (500 sheets) of paper uses six per cent of a tree.

One tree makes 16.67 reams of copy paper, or 8,335 sheets.

One carton (10 reams) of 100 per cent virgin copier paper uses 60 per cent of a
tree.

One ton of coated, non-recycled higher-end
magazine paper (used for high quality photographic
magazines) uses more than 15 trees.

One ton of coated, non-recycled lower-end magazine

paper (used for news magazines and most
catalogues) uses nearly eight trees.

Minimise energy use

Wasting energy also costs organisations and the planet a great deal. Many
organisations have developed policies and procedures to save energy. These
include:

« providing training programs on smart energy practices so that employees can
practise energy efficiency

« turning off equipment when not in use

« using power-save functions for equipment

o refilling toner and ink cartridges from printers.
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Resource conservation

Here are some tips for practising conservation.

Resource conservation tips

¢ Use the power-save function on printers when they are not in
use.

¢ Print and copy on both sides of the page, where possible.

* Use recycled paper (paper used on one side) in the
photocopier and printer for rough drafts.

¢ Use recycled paper for telephone messages.
* Place a recycling bin near the photocopier.

Practice task 4

Look at the following statements and decide whether they are true or false.
1. Screen savers save energy.

2. Turning off computers crashes the hard drive.
3. Refilled toner or ink cartridges leak everywhere and make an incredible mess.
4. Putting computers into sleep mode when they are inactive saves energy.

5. Printing and filing all documents in hard copy does not put a high demand on resource
consumption.

24
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Summary

1. The aim of ergonomics is to reduce the risk of injury by applying safe work
practices.

2. Your work environment can be organised in accordance with ergonomic
requirements by adapting workstations, tools and equipment to meet your
needs and ensure a safe, comfortable and productive work environment.

3. When preparing an electronic presentation, you need to understand the
factors involved in planning including the purpose, audience and method
of presentation. All these factors influence the content, organisational
requirements, style and layout of the presentation.

4. Organise your work program to ensure you have a balance of repetitive and
other activities, regular rest periods and exercise breaks.

5. Conserving resources in your workplace reduces costs and benefits the planet
by reducing greenhouse gases and the size of landfills. This can be achieved by
minimising both paper wastage and energy consumption.
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Learning checkpoint 1

Prepare to create a presentation

This learning checkpoint allows you to review your skills and knowledge in
preparing to create a presentation.

Part A

1. List reasons why a person may suffer physical discomfort when spending a lot
of time at a workstation.

2. For each reason you have listed above, describe a solution that could relieve
physical discomfort.

26
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3. Describe four types of office equipment you could use to help your posture in
the workplace. Explain the benefits of each piece of equipment.

4. 'This chapter discussed two ways of conserving resources in an office
environment: minimising paper wastage and minimising energy use. Using
this table, list as many conservation techniques as you can think of, that is, not
just the ideas listed in the chapter. Find at least four more ways of conservation

for each category below.

Minimising paper wastage Minimising energy use
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5. Research an organisation or summarise how your workplace manages wastage
of paper and energy.

a) Are its methods to avoid waste thorough and efficient?

b) List as many ways as you can think of for your organisation to improve its
paper and energy conservation.

28
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6. Read the case study, then answer the questions that follow.

Case study

Angelina works as an administration officer. Her main tasks are reception duties, word
processing, handling the mail and filing. Most days Angelina’s manager gives her urgent
work in the afternoon that needs to be completed that day. Her time lines are always very
tight and she often finds that she has to work during her lunch hour and for an extra half
hour in the evening. She is always exhausted and is becoming stressed.

To make matters worse, Angelina finds that work is often just dropped on her desk, which
makes her desk disorganised and difficult to use. She can’t alter her chair and there is
glare coming from her monitor. She often leaves work with a headache and a backache.

a) List all the unsafe work practices Angelina experiences.

b) For each of the unsafe practices you have listed in the question above,
describe a solution.
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¢) Describe why work organisation and ergonomics lead to better

employee health.

PartB
Are the following statements true or false? Tick the relevant column beside the
statement.
True False

The purpose, audience and method of your presentation will have an

impact on the content, organisational requirements, style and layout

of the presentation.

If you know how to use an overhead projector, then you will know how

to use a data projector.

Having a hard copy of the presenter notes or audience handouts can

add value to an electronic presentation.

During your day you should carry out a variety of tasks to prevent

repetitive actions causing undue stress on your body.

continued ...
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... continued

The level of expertise your audience members have in the subject
you are presenting is irrelevant to the content you provide in your
electronic presentation.

The audience will not remember everything from a presentation,
so handouts are useful, particularly if the presentation is about
something the audience needs to recall.

A data projector is commonly used for PowerPoint presentations.

Using computers for too long without breaks can contribute to
backaches, neck ache, headaches, migraines and eyestrain.

Minimising paper and energy usage in the workplace is only the
responsibility of the managers.

You need to understand legislative requirements to be confident your
presentation complies with privacy and anti-discrimination laws and
ethical principles.

Part C

Select the correct answers for the following questions.

1. Which of the following are ergonomic concerns?
a) Environmental noise
b) Indoor air quality
¢) An uncomfortable office chair
d) All of the above

2. True or false: If no pain is noticed while you are doing repetitive tasks, then
you do not have to worry about cumulative stress.

3. True or false: Leaning forward while sitting can put stress on your back and
may lead to back pain.

4. Cumulative stress disorders may result when:
a) you fall off your bike.
b) repeated stress is placed on tendons, nerves and muscles.

¢) you are exposed to toxic gases for harmful periods of time.
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10.

If your wrists are at an uncomfortable, odd angle when typing, you should try:
a) raising/lowering your chair until your wrists are at a comfortable angle.
b) raising your shoulders until your wrists are at a comfortable angle.

¢) putting the keyboard in your lap.

True or false: People who work in offices don’t have to worry about workplace
health and safety.

True or false: It is better to pound the keys when typing than to use a
light touch.

Sick Building Syndrome is caused by:
a) improper lighting.

b) excessive noise.

¢) poor indoor air quality.

d) all of the above.

It is best to position your monitor so that:
a) you have to lean forward to clearly see the text.
b) you can see overhead lights reflected on the screen.

¢) you can clearly read the text without leaning forward, twisting your neck,
or looking too far upwards.

True or false: The best position for a document holder is below and to the right
of the monitor.

32

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic 2
Create presentations

The electronic presentation you prepare may need resources such as
transparencies, an overhead projector or a data projector. You may also have
to prepare slides, notes or handouts. These may need to be designed to specific
organisational style requirements; for example, using the corporate logo and
colours.

You will use a software application to develop an electronic presentation. This
means understanding the functions of the software and how you can best use its
features for visual impact and emphasis. When designing a presentation, you need
to work within designated time lines to ensure the work is ready when it is needed;
for example, to meet a client’s requirements or be ready for a conference deadline.

The operating system used in this unit is Microsoft Windows 7, and the software
used is PowerPoint 2013.

In this topic you will learn how to:

2A  Understand organisational style requirements

2B Use software functions

2C Balance presentation features

2D Use advanced software features

2F  Work to a time line
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Understand organisational

style requirements

When creating an electronic presentation, speaker notes or an audience handout,
you need to be aware of your organisation’s preferred style. There may be
particular requirements you have to follow. For example, you may have to include
the company’s logo in the top left-hand corner of the slide, or use the company’s
corporate colours. The organisation may require specific music or a video clip to
accompany the presentation. Many organisations require a particular look for the
material they produce. By using the company logo,
company colours and a specific design layout, they
create a consistent and professional image that is
instantly recognisable to clients.

Companies often have a range of different

logos and variations on the designs for specific
purposes, or for special areas of their company’s
activities. If they have a marketing or marcomms
(marketing and communications) department, this
will normally be where you check which style is
appropriate for use in a particular circumstance. Style can also relate to sounds,
music and overall content. All of these must align with the chosen corporate image
and create a clear message to the audience about company values.

Find out whether your organisation has a preferred style for overheads and slides. Many
organisations have a template for creating electronic presentations. The following example
outlines the electronic design requirements of an organisation called Impact.

Design requirements for Impact:

* One heading per slide

* All headings to be Arial and all text to be Times New Roman
¢ All headings to be bold and in font size 24

¢ All text to be in font size 16

¢ Use square bullet points

¢ Use three bulleted points per slide

¢ Use no more than two fonts
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Example: introduction slide style

The following example shows the information required by an organisation for an introductory

slide.
Company logo ]

~Body Style Inc.
Shaping your future

Title of

presentation

A Healthy Future

Name and title of
presenter

John Lucas
Managing Director

Example: presentation slide

The following example shows the information required by an organisation for a presentation
slide.

Seminar: A healthy future

Overview
» What s a healthy lifestyle?
“—> - Strategies for planning your future

« Success stories

Body Style Inc.
Shaping your future

Avoid distractions

If your electronic presentation is too busy, it can distract your audience from
the content. Try to keep the presentation clear and concise and easy to view and
listen to.

If the content of your presentation is ‘heavy going’ for your audience, it can help to
break it up with the occasional light-hearted slide, such as a cartoon relevant to the
subject being delivered, a photograph or an amusing quote.
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Distractions may include:

« heavy colour

» not enough colour contrast between the main text and the background

o irrelevant animation of words or illustrations

o irrelevant illustrations

« multiple transitions either within a slide or throughout the whole presentation
» overly busy or dominant backgrounds

« overuse of sound

» too many words or pictures per slide

o too many small or varied fonts.

Practice task 5

Explain why organisations set style and layout guides for electronic presentations.
Consider style elements such as:

e company logos
¢ bullet points
* date and header location.
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Use software functions

You are now going to learn how to prepare an electronic presentation. You will
need to have access to a computer and Microsoft PowerPoint. The operating
system used in this unit is Microsoft Windows 7 and the software is PowerPoint
2013. To design your presentation you need to develop an understanding of the
software functions and features of PowerPoint; that is, what the program allows
you to do. This will enable you to prepare a presentation that has a consistent style
and visual impact.

In this part of the unit you will:

o create a slide show

o apply a design template

o add content

o write or draw on slides

o applyastyle

« create handouts and speaker notes.

PowerPoint functions

PowerPoint uses slides to build an electronic presentation. A slide is a single frame
in a presentation and a presentation comprises a group of slides. Before you start to
design your presentation, you should become familiar with the names of some of
the PowerPoint functions. Look at the functions and descriptions outlined here.

Placeholders

KBoxes with dotted lines that appear when you create a new slide.

Slide Master

Allows you to change the style of text and have the style reflected
throughout the whole presentation.

Notes Master

KA”OWS you to create notes when working on your presentation.
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Importing

Allows you to import information from other applications such as
Word or Excel, as well as images or graphics.

Handout Master

kAIIows you to create handouts to go with your presentation.

Colour schemes

A selection of background colours that you can apply to your
presentation.

Templates

Templates contain colour schemes and text formatting to design a
presentation with a particular look. You can alter the colours and
text formats chosen within the template itself to customise these.

Hyperlinks

Allows you to create a link in the presentation to a place within
that same presentation, or to another software file (for example,
Word) or website.

N/ N N N

Plan your presentation

As previously discussed, you need to plan your presentation before you begin. This
means working out the purpose, audience and presentation method.

Then you need to prepare the content of your presentation. The best way to do
this is to create a storyboard to help you map out the information you are going to
present.
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Here are the steps that are required to plan a presentation.

Purpose

What is your presentation going to be about? If you are in the workplace,
discuss this with your manager. You need to identify a subject that is useful
to your organisation. If you are not in the workplace, choose any topic.

For example, you could prepare a presentation about where you live, your
favourite country, your pet or a football team. Make sure you discuss this
idea with your tutor before you start.

Audience

Decide on an audience for your presentation. It may include colleagues

at work or fellow students. If you are a distance student, your audience
might include family members or friends. When considering your audience,
decide how much they already know about the subject you have chosen.
This will dictate the simplicity or complexity of the content of your
presentation.

Method of presentation

Unless you decide on an alternative method with your manager, you will
show your presentation in front of an audience. You will need to design
speaker and handout notes.

Storyboard

A storyboard is basically an outline of the major points of your
presentation. It should give a general idea of where text, pictures or
diagrams will go and the order in which you will talk about them. To create
a storyboard, you first need to decide on an outline for the main points you
want to develop in your presentation. Once you have done this, decide how
many slides will be needed for each main point. Also, remember to include
an introductory and conclusion slide.

Consider the next example of a presentation outline.

Outline for electronic presentation

Slide 1

Title page with graphic

Slide 2

Introductory page, bullet points for 3 major topics

Slides 3-5 Content for topic 1

Slides 6-8 Content for topic 2

Slides 9-11 | Content for topic 3

Slide 12 Conclusion
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Create a slide show

The next step is to use PowerPoint to create a slide show for your presentation.
Follow these steps.

1. Open PowerPoint.

2. Select a layout for your slide from the selections using Layout in the Slides
group. The option below is for a title and subtitle to be used. Alternatively
you may select a title and content slide or a blank one to commence with. The
rectangular areas on the slide are called placeholders. These are used to hold
text and graphics or to import information from other applications such as
Word or Excel. To add content, simply click inside the placeholder and enter
the text you want.

=

Click to add title

Click to add subtitle

3. To add the remaining slides that you need for your presentation, click New
Slide. Under the Design tab on the ribbon choose, one by one, the slides best
suited to the content you have written.

4. Save your presentation using a suitable name.

Apply a design template

When you create a template you create a file (.potx) that captures any
customisations that you make to a slide master, layout and theme combination.
Templates store design information that you can apply to a presentation to
consistently format the content on all slides.
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Below is an example of a template.

Contemporary Photo Album

This template contains placeholder content ‘Contemporary Photo Album’. It also
contains formatting, colour, background and layout features.

Each template contains a slide master that must have at least one layout (but can
contain more) for you to use in a presentation. While the preceding template
was created by a designer, you too can create a template by creating one or more
masters, adding layouts, and then applying a theme.

Create a template

Use the following steps to create a template of your choice.

Go to the Design tab. If you want to use a default slide master, choose one from
the designs shown at the top of the screen. If you want to add another slide master
or create a new slide master, refer to PowerPoint Help by clicking on the question
mark symbol (on the top right of your window) and select relevant topics following

the instructions provided.
H PowerPoint Help

PowerPoint Help - b
R g PowerPoint Help
£ YW A cestea new shde master Menu

Video: Create a new slide master and
layouts

By customizing slide mastens. you Can creale precisely
B prasantasion dasign and layouts you naad i you
wird & pection of yoor presantation 1o look dlfaant
fom

v

What is a slide master?

WWhat is a side master? Skde mastorn ae desigred 10

Balp you craste great locking prasentatons in Mas time
YOU #9d naw sides that are Based on those layouts

Use slide masters to customize 3
presentation

107, Use side mastars 50 customize a presantation
440, Cusdomize the shde master. 501, Customize
emasler layouds. 503 Craale 8 new slide master and
fayata

Copy and paste a slide master from one

presentation to another
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Note: The PowerPoint Help menu has a search feature, so you may type in your
questions to find relevant topics and assistance.

Apply a layout by using the standard layouts that are built into PowerPoint 2013. If
you want to customise your layout, see Layout in the help menu.

1. Go to the File tab, and then click Save As. Choose where you want to save
the file.

2. In the File name box, type a file name, or do nothing to accept the suggested
file name.

3. In the Save as type drop-down menu, click PowerPoint Template, and then
click Save.

Background styles

Background styles are background fill variations from different combinations of
theme colours and background intensities in the current document theme. Theme
colours, theme fonts, and theme effects make up a theme background. A theme
may be applied to a file as a single selection.

Click on the relevant slide to add a background style to your presentation. To select
multiple slides, click the first slide and then press and hold Ctrl while you click the
other slides.

1. On the Design tab, in the Variants group, click the arrow, the drop-down
menu for Colors, Fonts, Effects and Background Styles will appear. Go down to
Background Styles.

] &f
e s - .-El---- = Slide Format

Size » Background

Variants Customize

2. Right-click the background style you want, and then do one of the following:

« To apply the background style to the selected slides, click Apply to Selected
Slides.

N -

(8

« To apply the background style to all of the slides in your presentation, click
Apply to All Slides.
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« To replace the background style for the selected slides and any other
slides in the presentation that uses the same slide master, click Apply to
Matching Slides. This option is available only when your presentation
contains multiple slide masters.

-—a el | ESCRNE S S v .
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0
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=S CI.iCk to add title
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Add content

The next step is to add the content of your presentation. Refer back to what you did
in Practice task 5 and follow these steps.

1.
2.

Open your presentation in the Home view.

Go from slide to slide by clicking on the slide thumbnails to the left of
the pane.

Click on your title slide. Click inside the placeholders and add the title and
subtitle of your work. If you have chosen to use a title page with a graphic,
select a suitable graphic via the Insert tab to import clip art, smart art, a chart,
a picture or a photograph. There are various options available for importing
images and graphics. Take some time to explore the options available. You can
be very creative and have some fun learning how to do this.

Go to each of your slides by clicking on the thumbnails and add the content
that you developed earlier.

View your presentation by going to the Slide Show tab, then click From
Beginning. In this view you can see the slides as they will appear in your
presentation. To move from slide to slide, press Enter, or just left-click
your mouse.

If you want to change the sequence of your slides, use View, Slide Sorter. This
view allows you to see all your slides at once. You can click on and drag slides
into a different sequence.

Save your presentation.
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Here is an example of a slide displaying a title, content, graphics and a standard
design template.

Management

fraining Mm

presentation

Write or draw on slides

When you are running a presentation you might like to circle, underline,
draw arrows or make other marks on the slides to emphasise a point or show
connections. To write on slides during your slide show, do the following:

1. In Slide Show view, from the Start Slide Show group, click From Beginning to
start your presentation. Right-click the slide that you want to write on, point to

Pointer Options, and then click a pen or highlighter option.

2. Hold down the left mouse button and drag to write or draw on your slides.

Company Logos

3. Change the pen colour by right clicking the mouse and selecting Pointer
Options, Ink Color. Select a colour of your choice.

4. To remove some or all of the ink or highlighter, right-click the slide and go to
Pointer Options to select either Eraser or Erase All Ink on Slide. From here
you may also select Screen and Show/Hide ink markup.

5. To turn off the pen or highlighter, resume the pointer and continue advancing

through your presentation, right-click the slide, go to Pointer Options and
click Arrow.
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Styles

Once you have added the content to your
presentation, you may need to apply a style. This
will ensure the format is consistent throughout
the whole presentation.

To apply a style, you must use the Slide Master.
The Slide Master is similar to a template. It allows
you to choose a style and format the text. These
choices will be reflected throughout the whole
presentation.

You can also modify the header and footer on the Slide Master to include text,
slide numbers and the date and time. There are placeholders for all of these
elements. These changes will also be reflected throughout the whole presentation.

Apply a style
To apply a consistent style to your presentation, follow these steps.
1. Open your presentation in Normal view.

2. Select View, Slide Master. You should see a screen similar to the following.
Whatever formatting you apply to this slide will be reflected throughout your
whole presentation.

3. Inside the placeholder, click Click to edit Master title style. Choose formatting
to suit your title from the formatting toolbar. By hovering over a Word Art style
you can see what the impact of the style will be on your title. This title will be
on your title slide and will also be the heading on all subsequent slides. Select a
WordArt style.

4. Inside the placeholder, click Click to edit Master text styles. Choose
formatting to suit your text from the formatting toolbar. If you have written
different levels of text, choose formatting to suit all levels.

5. To view your choices select View, Normal. If you are unhappy with your
choices, go back and alter them.

6. To add footer information select Insert, Header and Footer. Select Slide.
7. Check Date and time checkbox.

8. 'The Update automatically button will be selected. This will make sure that the
date and time on your presentation is always correct.

9. Check the Footer checkbox and click inside the Footer to add a suitable footer
for your presentation. Click Apply to All

10. View your new style by going to the Slide Show tab.

11. Close your presentation.
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Create handouts and speaker notes

PowerPoint also allows you to create audience
handouts and presenter speaker notes that

can be viewed, edited or printed along with a
presentation. Handouts are basically thumbnails
of slides printed together on a sheet of paper.
Speaker notes can be developed for the presenter.
They are meant to aid the oral presentation and
are used to support the slides. Handouts and -
speaker notes can be customised to suit specific
requirements; for example, headers and footers

can be added.

Create handouts

Earlier, you used the Slide Master to make the style of your slides consistent. You
are now going to use the Handout Master to add information to your handouts.
This will then be reproduced on all of the handouts in your presentation. The
information you add using the Handout Master will only appear on your
handouts, not on your slides.

Follow these steps.

1. Go to the View tab and select Handout Master. You will see a template
displaying blank outlines of your slides.

2. Within the Handout template area there are four editable regions (on the four
corners of the page). These include:
» Header Area
« Footer Area
« Number Area

o Date Area.

3. Click on the Header Area. The placeholders will be displayed.
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To see more clearly, select 100% from the zoom function on your bottom right-
hand toolbar.

E == B T -——F—+ 100% [
Enter a suitable header for your presentation. Enter information in the Date,

Footer and Number areas.

The information you have entered on the Handout Master will appear on all
handouts you print for your presentation.

Save and close your presentation.

Srodey

Create speaker notes

If you add speaker notes to your PowerPoint presentation, you will be able to
deliver the presentation smoothly, without worrying about forgetting the main
points. If you use the Notes Master, you can add header and footer information to
your notes as you did with the Handout Master.

For the purpose of this exercise, you are going to add notes to individual slides
to help with the verbal presentation of your work. Before you begin, you need to
decide which slides need notes.

Follow these steps.

L.

Open your presentation in Normal view. Decide which slides you would like to
add notes to.

From View select Notes Page.

To see your notes more clearly, select 100% from the zoom function on your
bottom right-hand toolbar.
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4. Click the text placeholder and begin typing your speaker notes.

5. Save your work. You will print out these speaker notes in Topic 3.

-
.
-

\

Company Logos

WHO! yOu 108 B WhO? yOu O

Click to add text

H Speaker Notes

Practice task 6

You are going to create an outline for your presentation and then develop the outline into a

storyboard. Keep your presentation to 12 slides or fewer. Sketch or word process your work.
Follow these steps.

¢ Create an outline. Decide how many slides you will have and what content will be
dedicated to which slide. Use the previous example to help you.

¢ Create a storyboard. Write the content for each slide.
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2C Balance presentation features

PowerPoint also has features that allow you to add visual impact and emphasis to
the content of your presentation. It is important to find the right balance of these
features. You don’t want to distract or take away from the important information
in your presentation.

Before you start adding features to your presentation, you should become familiar
with some of their names.

Look at the following presentation features and descriptions.

Transition

This controls the way slides are presented. For example, they
might enter from the left to the right or from the right to the left.

Animation

This defines how content on the slide is presented. For example,
text can fly into or dissolve on the slide.

Graphics

Pictures can be added to slides using Clip Art or by scanning
photographs or other pictures into the computer.

Timing and pace

You can automatically control the transition time between each
slide.

Music, sound and video

Video and audio files can be added to enhance a presentation.
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Apply transitions

Slide transitions are the animation-like effects that occur in Slide Show view
when you move from one slide to the next. You can control the speed of each slide
transition effect, and you can also add sound.

PowerPoint includes many different types of slide transitions, including:

e 1no transition o Dblinds horizontal

o blinds vertical e boxin

+ boxout o checkerboard across
o checkerboard down e comb horizontal.

e comb vertical
Add the same slide transition to all of the slides in
your presentation

1. On the Home tab, click a slide thumbnail (you
need to be in Normal View for this to work).

2. On the Transitions tab, in the Transition to
This Slide group, click a slide transition effect.

3. To set the slide transition speed, in the
Timing group, click the arrows next to
Duration, to increase or decrease the speed.

4. In the Timing group, click Apply to All.

Add different slide transitions to the slides in your
presentation
1. On the Home tab, click a slide thumbnail.

2. On the Transitions tab, in the Transition to This Slide group, click the slide
transition effect that you want for that slide.

3. To set the slide transition speed, in the Timing group, click the arrows next to
Duration, to increase or decrease the speed.

4. To add a different slide transition to another slide in your presentation, repeat
steps 2 through to 4.

P~ a9 ———— e ——
—~ . . | wonum
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Add sound to slide transitions

1. On the Home tab, click a slide thumbnail.

2. On the Transitions tab, in the Transition to This Slide group, click the arrow
next to Transition Sound, and then do one of the following:

o To add a sound from the list, select the
sound that you want.

e To add a sound not found on the list,
select Other Sound, locate the sound file
that you want to add, and then click OK.

o To add sound to a different slide
transition, repeat steps 2 and 3.

Graphics

Graphics can be included in your presentation by selecting Insert and choosing
from the Images and Illustrations groupings. You can easily insert photos or a set
of photos from file or online, clip art, shapes or charts.

You can also use a feature called SmartArt to include graphics in your
presentation. A SmartArt graphic is a visual representation of your information
that you can create quickly and easily, choosing from among many different
layouts, to effectively communicate your message or ideas. For example, you can
insert hierarchical charts, pyramids or arrows with text.

You can create a SmartArt graphic in Microsoft Office Excel, Word or PowerPoint
2013, or in an email message in Microsoft Office Outlook 2013. Although you
cannot create a SmartArt graphic in other

2013 Office programs, you can copy and paste
SmartArt graphics as images into those programs.

Because presentations often contain slides with
bulleted lists, you can quickly convert slide text
to a SmartArt graphic. To learn more about using
SmartArt graphic features, read the information
available in PowerPoint Help.

Create a SmartArt graphic

1. On the Insert tab, in the Illustrations group, click SmartArt.

FAREN |

Shapes SmartArt Chart

-

Hllustrations
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2. In the Choose a SmartArt Graphic dialog box, click the type and layout you
want. Enter your text by doing one of the following:

 Click in a shape in your SmartArt graphic, and then type your text.

o Open the Text Pane from the Design tab of SmartArt Tools. Click [Text]
in the Text pane, and then type or paste your text. Alternatively, copy text
from another program, click [Text], and then paste into the Text pane.

Animation

You may wish to add an animation to your SmartArt graphic; for example, you
can make a shape fly in quickly from one side of your screen or slowly fade in.
Here is the process for adding animation to graphics.

Adding animation to SmartArt graphics

To decide which animation works best with the layout for your SmartArt,
view your information in the SmartArt graphic Text Pane, since most
animation starts at the top of the Text Pane and moves down. You can also
play an animation in reverse order.

If the Text Pane is not visible, you can display it.

The animations that are available depend on the layout you choose for your
SmartArt graphic, but you can always animate all of the shapes at once or
one shape at time.

The best way to animate your SmartArt graphic is to use the choices under
the Animations tab. If necessary, you can customise an animation using
Effect Options in the Animation Pane.

Animated items are noted on the slide by nonprinting numbered tags.
These tags correspond to the animations in the Animation Pane, which
appear only in Normal view with the Animation task pane displayed.

Apply animation sparingly to prevent obscuring your message or
overwhelming your audience.

Add an animation

1. Click the SmartArt graphic that you want to animate.

2. On the Animations tab, select the animation that you want from the
Animation group.
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3. You can choose to animate your graphic as one object or as one shape at a time
by going to Effect Options on the Animations tab.

4. To reverse the order of your animation, go to the drop-down menu next to the
appropriate animation in the Animation Pane and select Effect Options. Click
the SmartArt Animation tab, and then check the box next to Reverse order.

5. You can review your animations during or after completion by clicking
the Preview button on the Animations tab or the Play button in the
Animation Pane.

Add sound to an animation

1. You must have previously added an animation effect to the text or object.

2. Click the slide that contains the animation effect to which you want to add
a sound.

3. On the Animations tab, in the Advanced Animations group, click
Animation Pane.

4. Inthe Animation Pane, click the arrow to the right of the animation effect in
the Custom Animation list, and then click Effect Options.

5. On the Effect tab, under Enhancements, click the arrow in the Sound list, and
then do one of the following:
o To add a sound from the list, click a sound.

o To add a sound from a file, click Other Sound, and then locate the sound
file that you want to use.

Timing and pace

The timing and pace of a presentation are also
important. You may choose to manually control
how the slides and content of your presentation
will be displayed. Or, you can pre-set the time
and pace using PowerPoint. Using this function,
you can have slides that appear after a certain
amount of time has passed. The amount of time
you set will depend on how much information
is contained within the slide, and how much
emphasis you want to place on the information.

Rehearse and time the delivery of a presentation

It is a good idea to rehearse your presentation to ensure it meets your time frame.
To do this, use the Slide Timing feature to record the time that you need to present
each slide, then use the recorded times to advance the slides automatically when
you are actually presenting.
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1. On the Slide Show tab, in the Set Up group, click Rehearse Timings.

2. The Rehearsal toolbar appears, and the Slide Time box begins timing the
presentation.

= [l 0:00:06 €  0:00:06

Total time for
presentation

Next Pause Slide Time Repeat

3. While you time your presentation, do one or more of the following on the
Rehearsal toolbar:

« To move to the next slide, click Next.

» To temporarily stop recording the time, click Pause.

» To restart recording the time after pausing, click Pause.

o To restart recording the time for the current slide, click Repeat.

o After you set the time for the last slide, a message box displays the total
time for the presentation and prompts you to do one of the following:

— To keep the recorded slide timings, click Yes.
— To discard the recorded slide timings, click No.
o Slide Sorter view appears and displays the time of each slide in your

presentation.

If you do not want the slides in your presentation to advance automatically by
using the slide timings that you recorded, do the following to turn the slide
timings off:
« On the Slide Show tab, in the Set Up group, clear the Use Timings
check box.

« Note: To turn the slide timings on again, select the Use Timings check box.

Music, sound and video

To make a multimedia presentation you can add
music, sound or video. These are added from files
on your computer. You will need speakers and a
sound card to be able to play sound and music in
your presentation.
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Add music or sound

To add music or sound to your presentation, follow these steps.

1.
2.

View your presentation in Normal view.
Select Insert, and Video or Audio from the Media group.

Video or Audio may be located either Online or From My PC. Locate and
insert the sound you want.

You can record your own audio to insert into your presentation. Select Insert,
and Record Audio.

Add a video clip

To add video to your presentation, follow these steps.

L.
2.

View your presentation in Normal view.

Select Insert and Video from the Media group. Select a movie either From My
PC or Online.

A message will be displayed. If you want the video to play automatically when you
go to the slide, click Yes. If you want the video to play only when you click the
video icon during a slide show, click No.

Practice task 7

1. Write a sentence explaining what a transition is.

2. Write a sentence explaining what animation is.

3. How you would change the colour scheme in a graphic?

4. Which view must your presentation be in before inserting sound or video?

continued ...
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... continued

5. Explain why you think presentation features in PowerPoint add visual impact and emphasis
to a presentation.

6. Explain the benefits of using SmartArt when inserting graphics into a presentation.

7. How do you go about playing music from a soundtrack during your presentation?
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Use advanced software features

By using the advanced software features in PowerPoint, you can streamline and
customise your presentation to meet the needs of several different audiences.
Advanced software features include basic and hyperlinked custom shows.

By creating custom shows in PowerPoint 2013, you can adapt a single presentation
for a variety of audiences. You can use a custom show to present an independent
group of slides from your presentation, or to create a hyperlink to a group of slides
in your presentation.

There are two kinds of custom show only: basic and hyperlinked. A basic custom
show can be a separate presentation or a presentation that includes some of the
slides from another presentation. A hyperlinked custom show provides a quick
way to navigate to one or more separate presentations.

The custom shows feature gives you the flexibility to choose which sections you
present to which audience type without having to create totally separate versions of
your presentation.

Examples where the custom show feature could be used with different audiences
for a similar presentation are listed below.

Examples where the custom show feature could
be used with different audiences

* One group requiring brief introductory information and then the advanced
information

* Another requiring a more extended version of the introductory information,
before proceeding to the advanced information

* Other supporting material that may vary, depending on your audience type,
and which you wish to access at different points of your presentation

Basic custom shows

You can use a basic custom show to give a
more targeted presentation to different groups
of people in your organisation. For example,
if your presentation contains a total of five
slides, you can create a custom show named slidesfor
Custom 1 that includes just slides 1, 3, and Coster 1
5. You can create a second custom show
named Custom 2 that includes slides 1, 2, 4,
and 5. When you create a custom show from
an original presentation, you can always

run the entire original presentation in the
correct order.

i Slides for
Custom 2

l
] ] ]} ]
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Hyperlinked custom shows

You can use a hyperlinked custom show to organise content in a presentation. For
example, if you create a primary custom show about your company’s new overall
organisation, you can then create a custom show for each department within the
organisation and link to these shows from the primary presentation.

@ @J <— Custom A
B O
Primary I |
show with = F‘_; J'
|@ ‘E]l <— Custom B

2 =

You can also use a hyperlinked custom show to create a table of contents slide (or
an agenda slide). A contents or agenda slide is similar to a web page in that it is
an index of your presentation from which you can create hyperlinks and move
between the different sections of your presentation and back again.

Create a basic custom show

1. On the Slide Show tab, in the Start Slide Show group, click the arrow next to
Custom Slide Show, and then click Custom Shows.

2. In the Custom Shows dialog box, click New.

3. Under Slides in presentation, click the slides that you want to include in the
custom show, and then click Add.

4. To select multiple sequential slides, click the first slide, and then hold down
Shift while you click the last slide that you want to select. To select multiple
non-sequential slides, hold down Ctrl while you click each slide that you want
to select.
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5.

To change the order in which slides appear, under Slides in custom show,
click a slide, and then click one of the arrows to move the slide up or down in
the list.

Type a name in the Slide show name box, and then click OK. To create
additional custom shows with any slides in your presentation, repeat steps 1
through 5.

To preview a custom show, click the name of the show in the Custom Shows
dialog box, and then click Show.

Create a hyperlinked custom show

1.

On the Slide Show tab, in the Start Slide Show group, click the arrow next to
Custom Slide Show, and then click Custom Shows.

In the Custom Shows dialog box, click New.

Under Slides in presentation, click the slides that you want to include in the
main custom show, and click Add.

Tip: To select multiple sequential slides, click the first slide, and then hold
down Shift while you click the last slide that you want to select. To select
multiple non sequential slides, hold down Ctrl while you click each slide that
you want to select.

To change the order in which slides appear, under Slides in custom show,
click a slide, and then click one of the arrows to move the slide up or down in
the list.

Type a name in the Slide show name box, and then click OK. To create
additional custom shows with any slides in your presentation, repeat steps 1
through 5.

To create a hyperlink from the main show to a supporting show, follow
these steps.

Step 1

kSeIect the text or object that you want to represent the hyperlink.

Step 2

kOn the Insert tab, in the Links group, click Hyperlink.
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Step 3

LUnder Link to, click Place in This Document.

Step 4 T\

Do one of the following two steps:

¢ To link to a custom show, in the Place in This Document list,
select the custom show that you want to go to, and then select
the Show and return check box

¢ To link to a location in the current presentation, in the Select a
place in this document list, select the slide that you want to go
to.

\_ /

Start a custom show

1. To preview a custom show, click the name of
the show in the Custom Shows dialog box,
and then click Show.

2. On the Slide Show tab, in the Set Up group,
click Set Up Slide Show.

3. In the Set Up Show dialog box, under Show
slides, click Custom show, and then click the
custom show that you want.

4. Click OK.

Practice task 8

Create three simple presentations of at least five slides each and name them as
presentations 1, 2 and 3. Using these presentations, create a custom show where the second
slide of presentation 1 is hyperlinked to presentation 2, and the fourth slide of presentation 1
is linked to presentation 3.
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m Work to a time line

Whatever your work task, you will always have to work within a designated time
line. This means having the work ready by a specified time. You may have to
prepare a presentation for a client or meet a deadline, such as a conference.

Always find out when the presentation is required and enter this date in your
diary. Clarify and plan the task to work out how long it is likely to take. Careful
planning means there will be no last-minute panic. If you are developing an
electronic presentation for someone else, always ask when a draft of the material
is required. The presenter will generally want to rehearse the material and may
suggest further amendments or adjustments.

Example: checklist for planning work tasks

A checklist can sometimes help you plan a work task. Preparing presentations will become
less problematic once you are familiar with the requirements of your organisation. The
following table is an example of a useful planning checklist.

Prepare an Tuesday As outlined in draft.

electronic 10 May Company logo on all slides.
presentation ) ]

for Kyle for the Use company colours in headings.
board meeting. Use Arial bold for headings and

Times New Roman for text.
Draft ready by 7 May for rehearsal.
Print handouts and speaker notes.
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Practice task 9

1. Describe the steps you would take to prepare a presentation.

2. If your manager made some new demands at the last minute, what might be the
consequences?

3. Explain how using a checklist can help you deliver an electronic presentation on time.
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Summary

1. When creating an electronic presentation, speaker notes or an audience
handout, you need to be aware of your organisation’s preferred style, such as
inclusion of a logo or corporate colours. It is important the audience is not
distracted by unnecessary features.

2. A presentation needs to be carefully planned so that it addresses the purpose
and targets the correct audience.

3. 'The use of computer software such as Microsoft PowerPoint 2013 enables a
visually attractive electronic presentation to be prepared and displayed using
a series of slides and many features such as graphics, sound and transition
options.

4. PowerPoint has features which are used to add visual impact and emphasis to
the content of a presentation. It is important to find the right balance of these
features so as not to distract or take away from the important information in
the presentation.

5. By using the advanced software features in PowerPoint, you can streamline
and customise your presentation to meet the needs of several different
audiences. Advanced software features include basic and hyperlinked
custom shows.

6. When preparing a presentation, always be aware of organisational deadlines or
deadlines imposed by a client.
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Learning checkpoint 2

Create presentations

This learning checkpoint allows you to review your skills and knowledge in
creating presentations.

Part A

Read the case study. Write down your answers to the questions.

Claire was told to prepare an electronic presentation to show to external clients. She
knew that the clients wanted information about new legislation and how it was affecting
the organisation. She found lots of legislative documents and used the fine details to fill
the slides that made up the presentation.

Claire then produced speaker notes that contained additional, detailed information.
When Claire delivered her presentation, the audience seemed confused and some
clients appeared to fall asleep. She later found out the audience wanted a general
outline of the legislation and the details she presented to them on the slides and in her
notes were too complicated.

1. Describe what Claire should have done before producing the presentation.

2. What were the consequences of Claire’s poor planning?
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3. How could Claire have made the presentation more successful?

4. Why is it important to understand the purpose of a presentation, the audience
it is for and the best method for its delivery?

Part B

1. Match each method of presentation with the appropriate situation.

Face-to-face Trade fair

Self-running Staff meeting

Use yourself Conference in Shanghai
Online Training session
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2. The following tools and equipment are used to prepare and deliver
presentations:

o Data projector

o Speaker notes

o Internet access

» Network access

o Overhead transparencies
o Overhead projector

o Annotation pen

« Digital pointer

« Handouts

Decide which of these tools and/or equipment would be needed for each of the
presentations below.

This presentation needs
six transparencies. The
presenter wants notes and
the audience needs to have
additional information. The
presenter also wants to be
able to point to information
being projected.

This presentation uses
PowerPoint. The presenter
wants to be able to write on
slides and give the audience
a printed overview of the
information.

This electronic presentation
is going to be loaded

onto the web and

run continuously at a
conference. Hard copy
brochures are needed to
distribute to clients.
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3. Use Word to design a template for an organisational handout. Use the
following information about style and content. Print out your work and give it
to your tutor.

Style and content guidelines

Corporate logo: *Masons* (use this logo or make up your own)
Footer: with time, page number and date in Book Antiqua size 12
Header: with organisational name

4. Why should an organisation have a preferred style and layout for its electronic
presentations and hard copy handouts?

Part C

You are going to produce a presentation using summary slides and custom shows.
Use at least 12 slides for your presentation.

Think of a subject for your presentation. It can be about something you have
studied or anything that interests you. Talk to your tutor or if you are working,
talk to your manager about your topic before you begin.

Follow these guidelines.

« Use consistent style in your title and body text.

« Break up your presentation into three custom shows with a summary slide to
introduce each custom show.

o Create a table of contents slide at the beginning of your presentation that
contains headings from all three summary slides.
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« Use Rehearse Timings to pace your show.

« Write speaker notes and audience notes to support your presentation and print
them out.

« Use appropriate help sources when needed.

Part D

Imagine you have to teach a colleague one of the following subjects.
« How to create a basic custom show
» How to create a hyperlinked custom show

Write explanatory notes and create a step-by-step guide for the learner. Test your
lesson by teaching it to a colleague or friend.
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Part E

Write explanatory notes about the importance of preparing a presentation within
organisational time lines to meet both client and organisational deadlines.
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The quality and content of your electronic presentation reflects on the
professionalism of your organisation. You need to prevent and overcome any
problems using assistance available in the form of user manuals, training
documents, online help, professional development education and consultation
with colleagues.

To complete a professional presentation of a high standard, you need to ensure that
your presentation is carefully proofread and that all associated printed materials
are accurate and informative. Electronic presentations need to be securely saved
and stored to eliminate the possibility of loss or damage of the data contained in
them. There are several methods of ensuring safe storage of data.

In this topic you will learn how to:
3A  Overcome problems

3B Proofread your presentation
3C Print presentation materials

3D Store your presentation
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3 A Overcome problems

Sometimes you will experience a problem when
producing an electronic presentation. For instance,
you may find operating a particular software
function difficult and don’t know who to ask. It’s a
good idea to have a plan for dealing with the
unexpected. Organisations deal with difficulties in
a number of ways. They might have manuals or
training booklets. Some may even have a help desk
to assist employees.

Use PowerPoint Help

Microsoft PowerPoint 2013 provides a description of each icon or function on the
screen which is displayed by placing the pointer on the icon. A brief description of
the function will be displayed.

If you require additional information, you can seek assistance in Help. Simply
type in the keyword or phrase that you need help with, and a list of options will be
displayed to choose from. For example, if you wanted help with formatting, you
would type ‘formatting’.

You navigate the Help window similar to how you navigate the internet in a web
browser, such as Internet Explorer. You can use Help for a variety of reasons
depending on your needs. You might want tips on using your keyboard or your
mouse. Or you might want tips on using the features of the program more
effectively.

You can ask for help at any time by pressing the F1 function key or you can also
click on the question mark button = to do the same.

[Heed assistance?

LS 10 SrCh 0K 10 tell us Wit Yol re 300007 S0 and we 'l do
Sur best 10 find a0 snpwer

Read manuals

Most equipment and software comes with a user manual. These describe

the features and provide step-by-step instructions for use. Manuals include
information about functions, maintenance, use and WHS issues related to the
equipment or software.

Manuals can come in a paper-based or online format.
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There are many websites that have information about Microsoft Office
applications. These usually contain frequently asked questions (FAQs) and give
solutions to common problems. You can also download updates, tools and any
fixes that Microsoft has developed for its software problems.

You may find the following websites useful.
www.support.microsoft.com

This is Microsoft’s main site for finding help with Microsoft products. You can ask
questions online and download files, including service packs, drivers and patches.
You can also access the Microsoft Knowledge Base.

www.office.microsoft.com

This site provides resources for all Office applications. It has news, announcements
and useful files for you to download. You can open this site by choosing Help,
Office on the Web in all Office applications.

Use training booklets

There are many ways to learn about computer
functions and software packages. You can go to

a training course to learn a particular computer
function. Some suppliers also provide instructions
on how to use their equipment.

You may have received some training when you
started your job, but it should not stop there. It
is important to keep up-to-date with technology. . y
Try to locate the courses in your area that offer = S ==
software training. These courses usually provide S e

a comprehensive set of instructions or notes that are worth keeping for future
reference.

2/

4

Software help tips

Other sources of help for solving problems with word processing software include:
» accessing paper-based manuals and training booklets in your workplace
 finding websites that offer advice on software use

« asking colleagues for help and advice

e accessing training courses in your area.
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Practice task 10

1. Imagine you are having a problem a problem with software functionality. Where would you
go for help?

2. Do you ever experience software problems when producing an electronic presentation?
Describe the steps you would take to solve the problem.
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Proofread your presentation

Although you might write the text in your presentation very carefully, there will
probably still be some mistakes. It is better to find these during a rehearsal than in
front of an audience. Your presentation needs to be checked for spelling, grammar,

consistency and style. You can proofread your
work by closely reading it yourself first, then
getting someone else read it.

PowerPoint is equipped with an internal dictionary
that can help you correct words that are misspelled
in your presentation. As well as checking spelling,
PowerPoint can also check style to make sure

that each slide is consistent. Check with your
manager to determine the requirements of your
organisation. Then, make the necessary alterations
to the style of your presentation.

Check spelling and grammar

To check the spelling and grammar of your presentation, follow these steps:

1. Open your presentation and select the Review tab from the ribbon.

2. Click on the ABC Spelling icon at the top left hand of your screen.

The AutoCorrect function in PowerPoint 2013 is a default setting of common
misspellings and symbols, which you can modify. This feature corrects typos and
misspelled words, and inserts symbols and other pieces of text. Text included in

hyperlinks is not automatically corrected.

The AutoCorrect feature also includes a series of parallel lists, where a particular
word typed can be automatically replaced by another word.

Use the AutoCorrect feature to:

« automatically correct typing errors and misspelled words; for example, if you

type ‘teh’ instead of ‘the’

« insert symbols; for example, you can type (c) to insert ©

« insert sentences such as repeatedly used phrases.
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Change how PowerPoint corrects and formats

your text

To automatically turn spelling and grammar check on or oft:

1. Click the Microsoft File tab and then click Options.

2. Click Proofing.

3. Under When correcting spelling in
spelling and grammar errors check

Powr ® et Citune

PowerPoint, select or clear the Hide
box, and then click OK.

2l

Rl

 gnom wards n UPPRCAR

P ignom warts fhat contan sunpens
F kpoeistene erd fle sdcreses

' Tug xpested wosds

™ Intoncg aconmed vpperane o Frand
™ Seagent from wan txtomn trvy

Lusors D tonmie.

Greting 1 P Pasr

N Cred sptiing i ytu hpe
P Mde oeiteg ind grammar sron

I™ Crark ragumes with spwling

Reched Eotament |

Frnch modes:  [Trad@cral ndnew melings vl
Spenal nodes [Tieeo ved forrs ety -,

Note: If you want to select the Hide spelling and grammar errors check box, you
must also select the Check spelling as you type check box.

Add an entry to the list of automatic corrections

To add an entry to the list of
automatic corrections:

1. Click the File Tab and then click
Options.

2. Click Proofing.

3. Under AutoCorrect options, click
AutoCorrect Options, and then
click the AutoCorrect tab.

4. In the Replace box, type a word
or phrase that you often mistype
or misspell. For example, type
usualy.

AutoCorrect: English (Australia) 2]
AutoCorrect | AutoFormat As You Type | Actions | Math AutoCorrect |

V¥ Show AutoCorrect Options buttons

[V Correct TWao INitial CApitals

¥ Capitalize first letter of sentences

i Capitalize first letter of table cells

v Capitalize names of days

¥ Correct accidental use of cAPS LOCK key
IV Replace text as you type

Exceptions... I

Replace: With:
cat [feline
can;t can't __A_I
candidtae candidate v
candidtaes candidates
can't of been can't have been
catagory category _v_l
Add IElETE |
™ A L use sugg from the spelling checker

ok | concel |
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5. In the With box, type the correct spelling of the word. For example, type
usually.

6. Click Add.

Add an entry during a spelling check

When a word is misspelled or mistyped, a wavy red line appears under it to alert
you to the mistake.

To add an entry during a spelling check:
1. Right-click a word that has a wavy red underline.

Note: If wavy red underlines do not appear under misspelled or mistyped words,
click the File tab, click Options, click Proofing, and then under When correcting
spelling in PowerPoint, select the Check spelling as you type check box.

2. On the shortcut menu, do one or more of the following:

o If the word appears in the list on the shortcut

menu, click the word that you want to replace St
the misspelled or mistyped word with. aliquot
o Ifthe list on the shortcut menu does not include aqua
the correct word that you want, click Spelling, aliquots
then click AutoCorrect, and the word should e
correct itself.
Ignore All
o If the word that you want to correct does not '
correct itself, it is not in the built-in dictionary. andtoDistonary

To add it to the built-in dictionary, click Add to
Dictionary.

PowerPoint provides a list of optional corrections for a misspelled or
mistyped word.

Change the contents of an entry

To change the contents of an entry:

1. Click the File tab and then click Options.
2. Click Proofing.

3. Under AutoCorrect options, click
AutoCorrect Options, and then click the
AutoCorrect tab.

4. In the list under the With box, select the entry
that you want to change.

5. Inthe With box, type the new entry, then
click Replace.
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Rename an entry

To rename an entry, you must delete the original entry, and then add the newly-
renamed entry:

L.
2.
3.

Click the File tab and then click Options.
Click Proofing.

Under AutoCorrect options, click AutoCorrect Options, and then click the
AutoCorrect tab.

In the list under the Replace box, click the entry that you want to rename, and
then click Delete.

Type a new name in the Replace box, and then click Add.

Prevent specific capitalisation and spelling

corrections

1. Click the File tab and then click Options.

2. Click Proofing.

3. Under AutoCorrect options, click AutoCorrect Options, and then click the

AutoCorrect tab.

4. Click Exceptions, and then do one or more of the following:

o To prevent AutoCorrect from capitalising a word that you type after
a specific abbreviation, click the First Letter tab, and then type the
abbreviation (including the full stop) in the Don’t capitalize after box.

o To prevent AutoCorrect from correcting a word that contains mixed
uppercase and lowercase letters, click the INitial CAps tab, and then type
the word in the Don’t correct box.

5. Click Add, and then click OK.

Practice task 11

Look at the following slide, then complete the tasks that follow.

1. Proofread the slide. Check for spelling, grammar, punctuation and consistency of style.
2. Rewrite the slide, amending it to include your corrections.

Soar Throats

Coursed by:

« contagius Vuusess,

« Infraction in tonsilis

« Bactaria such As strepp throat

« Alegory from polan or cats and dog’s

78

Unit release 1 (Aspire Version 1.1)
© Aspire Training & Consulting



Topic3
Finalise presentations

3C Print presentation materials

Once you have checked your presentation for spelling, grammar, consistency and
style, you may want to print out the information. Hard copies are useful to refer to
while the presentation is running. The information you print may be for your own
use, or for someone else in the organisation. If you are printing materials for
someone else, make sure that you discuss what they need before printing, as
alterations may be required.

You can print handouts, notes or outlines. You need to decide on the appropriate
materials for each presentation and have the printed copies available within the
designated time line. If you want to customise these presentation materials for
yourself or another person (for example, by adding
headers and footers), you can use the Handout
Master and Notes Master before printing the
materials. Remember that if you add information
using the Master, it will only appear on the
printout, not on your slides. You may also need to
assemble other presentation materials. These may
include items such as:

o outlines of the session for distribution

« additional information for use, such as
printouts from a website or handouts.

Print handouts

In PowerPoint you can print your slides as handouts for the audience. You can also
choose how many slides you would like on each handout. The following method
will print out an exact replica of your presentation slides.

Follow these steps.
1. Open the presentation for which you want to print handouts.
2. Click the File tab and click the arrow next to Print.

3. Under Settings, select from the slides drop-down menu the handout layout
option that you want from the list.

Handout tips

The Handouts (3 Slides Per Page) format provides lines for the audience to take
notes (see picture below).

To specify the page orientation, after you have selected handout layout options,
click the arrow under Orientation, and then click Landscape or Portrait.

Click Print.
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R

Note: If you want to print handouts in colour, select a colour printer. Click the
Microsoft Office Button, click the arrow next to Print, and then click Print
Preview. Under Print, click Options, point to Color/Greyscale, and then
click Color.

Print speaker notes

Speaker notes are to help the presenter outline any additional points they would
like to make verbally.

You can type and format your notes as you work in Normal view. But to see how
your notes pages will be printed and to see the full effect of any text formatting,

such as font colours, switch to Notes Page view. You can also check and change the
headers and footers of your notes in Notes Page view.

Each notes page shows an image of a slide, along with the notes that go with that
slide. In Notes Page view, you can embellish your notes with charts, pictures,
tables, or other illustrations.

To print speaker notes for your presentation, follow these steps:

1.
2.

Open the presentation for which you want to print notes.
Click the File tab, then click the arrow next to Print.

Under settings, click the slides drop-down menu, and then click Notes Pages
under Print Layout.

To specify the page orientation, click the arrow next to Orientation, and then
click Portrait or Landscape.

Click Print.

To set headers and footers, under settings, click Edit Header & Footer.
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Outline view

If you look at your presentation in Normal view,
you will see an outline of your work on the left-
hand side of the screen. If you choose to print

an outline, this is the information that will be
printed. Outlines help you to view the whole
presentation and make decisions about where you
have placed information. You may find that you
want to add new information or rearrange the old
information.

Print an outline

1 Powerpoint Slide Presentation
by Sam Smythe
2 Introduction
= Introduction
= Topic One
= Topic Two
= Topic Three
= Conclusion
3] Topic One
4 Think globally act locally

5 Topic Two

6 Topic Three

To print an outline of your presentation, follow these steps.

1. Open the presentation you want to print.

2. Click the File tab and select Print.

3. Under Settings select the Slides drop-down menu, then from Print Layout,

select Outline.

4. To specify the page orientation, click the arrow next to Orientation, and then

click Landscape or Portrait.

5. Click Print.
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Practice task 12

1. Why would you choose to print handouts?

2. How can printed speaker notes help when giving a presentation?

3. Why is printing an outline of your presentation useful?
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Store your presentation

How you store your presentation depends on the requirements of your
organisation and who needs to access to the presentation. If your presentation
needs to be available to all your colleagues, you would store it in an appropriate
place on the organisation’s server. Your colleagues can then access the presentation
from their workstation if they have PowerPoint installed on their computers.

An important task when creating and editing presentations is saving your work.
Saving the presentation ensures that you can edit
or print it again when required. Each organisation
has its own policies regarding the naming and
storing of electronic documents and it is important
that you follow these procedures so that you and
other staff can access the documents as required.

Most presentations you create will be stored
electronically and occasionally hard copies
(printouts) of the presentations may be stored in
the organisation’s paper-based filing system.

Electronic file storage

Each presentation needs to be easily identifiable. Your organisation is likely to have
an established system for naming electronic files to ensure all employees are able
to find files when required.

Folder structures and naming standards

Folders are used to organise files so they are easier to locate. Each organisation
uses folder structures and naming standards to ensure that all files are stored in
the correct location. If your organisation has a network, you may have shared
directories and folders that several staff may have access to. The advantages of
using shared directories and naming standards include the following.

Advantages of shared directories and naming standards

Organised files are easy to find. For example, it is much easier to find one
file in 20 than it is to find one in 100.

If an employee is away, other employees can check to see how much of a
document the employee has completed and finish it if necessary.

continued ...
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... continued

Work is less likely to be duplicated, as staff can check if there is already a
document created.

It is easy to share documents between employees.

Files stored in shared directories are normally backed up on a regular
basis.

Virus scans are normally run on shared folders on a regular basis.

To set up a shared directory, you have to find the shared network drive,
then go to the folder level. This is the first place to organise the directory.

Folders have a treelike structure that branches from a parent directory to
sub-folders in a hierarchical structure.

In this structure the server has three folders for three separate workgroups: Group A, Group
B and Group C. Group C has three major folders: Procedures, Personnel and Projects. The
Projects Folder has three folders: Project A, Project B and Project C. The Project C folder has
two documents: ProjectC_timelines and ProjectC_researchl. The file path for retrieving a
document starts at the server and ends when the correct document is located. For example,
to reach the ProjectC_timelines.doc, the file path is C:\GroupC\Projects\ProjectC\ProjectC_
timelines.docx.

SERVER (C Drive)
Group A
Group B
Group C
Procedures
Personnel
Projects
Project A
Project B
Project C

Project C_timelines.docx

Project C_researchl.docx
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Manage shared directories

When you have access to a shared directory to store your files, you may also have
access to files created by other employees. It is important that you check your files
and delete any that are no longer required on a regular basis to ensure the system
remains efficient. If you are planning to have a clean-up of your files, before you
delete any you should check with your supervisor which projects or clients you
need to keep files for. You should never delete or move files created by another
employee without their permission; always check first.

Organisations usually perform regular backups of shared directories and folders.
In larger organisations, a staff member from the IT department will usually be
responsible for this. If you are planning to delete a lot of files, it may be a good idea
to perform a backup of the files (which can be kept before deleting them).

Hard-copy storage

Many presentations stored digitally may also be stored in hard copy. This is a
safeguard against a catastrophic computer system failure. Hard-copy storage
requires space. It also requires a filing system that uses consistent, simple and
meaningful names similar to those used in digital storage.

Managing hard-copy documents is necessary to efficiently use storage space.
Retention schedules are used to determine which documents need to be kept and
for how long. Documents without permanent value may be scheduled for eventual
destruction. It is normal office practice for staff to perform archiving duties; that
is, removing inactive files and placing them in long-term storage when there is
not much other work to do. Retention schedules save space because only a limited
number of records have long-term value. The development and implementation of
a retention schedule also saves money, as it means that only records of enduring
value will be permanently retained.

Here is an example of a retention schedule.

Retention schedules for hard-copy documents
Credit card receipts and statements 2 years
Tax records 6 years
Accounts records 6 years
Invoices 1 year
Client correspondence 2 years
Presentations 6 months
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Apply security to documents

It is vital that passwords are used to ensure that
only authorised users are able to access files.
Access to an organisation’s data can be controlled
at a number of levels, including drives and files.
Employees can be given access to shared drives
and directories or individual files.

Network/operating
system logons

Most organisations have networks made up of more than one computer. Before
employees can use a computer that is connected to the network they must be
issued a logon username and password, which identifies them and allows them to
access the files on the network. Below are the instructions for selecting a password
and keeping your work secure.

Selecting a good password \

You should change your password on a regular basis and ensure
you do not tell anyone what it is. Your password should also not be
anything that can be easily guessed by other people, such as your
date of birth, name, family members’ names etc. Good passwords
contain a mixture of letters and numbers and are at least six to
eight characters long. Do not write your password down or keep it
near your computer.

/

Protecting individual files \

Depending on the network configuration, employees will have
their own drive for their files along with access to various shared
employee drives. Where information contained in files is sensitive
and not to be viewed by all employees, you can apply a password
to an individual file. Two levels of access can be applied:

* A password to open the file, which allows the file to be viewed
or printed

* A password to modify the file, which will let the user make
changes to the file

You can let any other person who needs to access the file know
the password.
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Practice task 13

Read for storing hard-copy documents, then answer the questions that follow.

Policy for storing hard-copy documents for electronic presentations

1. Place documents in a blue manila folder and place a white label on the top left-hand
corner. There are three categories of document with the following codes.

* Notes (speaker notes)
e Qutlines (audience notes)
2. Name your documents as follows:

e All information for Project Rialto must be named Rialto/your-document-name/code
and stored under R in the filing cabinet marked Building Projects.

e All information for Project Martin must be named Martin/your-document-name/code
and stored under M in the filing cabinet marked Distant Projects.

e All information for Project Collins must be named Collins/your-document-name/code
and stored under C in the filing cabinet marked Road Projects.

For example, transparencies for the Rialto project document called Personnel would be
called Rialto/Personnel/Trans and filed under R in the Building Projects cabinet.

1. Imagine you have produced some speaker notes for a presentation called Maple for the
Collins project. What would you name the file? Where would you store it?

2. Imagine you have produced an outline for a presentation called Copper for the Martin
project. What would you name it? Where would you store it?

3. Imagine you have produced some speaker notes for a presentation called Services for the
Rialto project. What would you name it? Where would your store it?

4. Describe the consequences of not having a policy for naming and storing hard or soft copy
documents.
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Summary

1. Use paper-based user manuals and training documents as well as online help
material to overcome problems when producing electronic presentations.

2. A presentation needs to be checked for spelling, grammar, consistency
and style.

3. Print presentation materials to suit the needs of the audience and the presenter.
If you are printing materials for someone else, make sure you discuss what
they need before printing.

4. You can print out handouts, notes, outlines, documents from the internet or
transparencies.

5. How a presentation is stored depends on organisational requirements and who
needs to have access to the presentation. There is a range of electronic storage
methods available.
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Learning checkpoint 3

Finalise presentations

This learning checkpoint allows you to review your skills and knowledge in
finalising presentations.

Part A

Describe how an organisation can organise and protect electronic information on
a server and hard copy information in a filing cabinet.

Part B

Read the case study, then answer the questions that follow.

Jonah has spent two hours working on a PowerPoint presentation for a meeting that
afternoon. He has created 10 slides and has almost finished the presentation. Suddenly,
there is a power failure that lasts five minutes. When the power is restored and he
accesses his presentation, he is alarmed to see that he has lost half of his presentation.
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1. Explain what steps Jonah could have taken to avoid losing work.

2. Describe the importance of protecting information when using
PowerPoint 2013.

Part C

Research an organisation or use your own workplace to find out the answers to the
following questions.

1. Explain what methods of proofreading presentations are used within the
organisation.

2. Make an assessment of how foolproof these methods are. Are there times when
errors are made and not detected before delivery of the presentation?
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3. How could proofreading be improved?

4. Describe the methods used in your organisation for overcoming problems with
design and production of electronic presentations.

5. What range of printed presentation materials are provided in your
organisation?

PartD

Assume you are preparing a policy about finalising electronic presentations in an
organisation. To make it comprehensive, logical and easy to read, include:

« methods of overcoming problems including user manuals, training
documents, advice from colleagues and electronic assistance

 best practice advice for proofreading presentations, including checking for
spelling, consistency in presentation features and style, in accordance with task
requirements

 options available for printing presentation materials.
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